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WINDOWS 

A computer is an electronic device that manipulates information, or data. It 

has the ability to store, retrieve, and process data. You may already know that 

you can use a computer to type documents, send email, play games, 

and browse the Web. You can also use it to edit or 

create spreadsheets, presentations, and even videos. 

Hardware is any part of your computer that has a physical structure, such as 

the keyboard or mouse. It also includes all of the computer's internal parts, 

which you can see in the image below. 

Software is any set of instructions that tells the hardware what to do and how 

to do it. Examples of software include web browsers, games, and word 

processors. 
 

MS WORD 

1.Home 

Home Tab in Microsoft Word is the default tab for editing and formatting the 

document in MS Word. The ribbon of Home Tab in Microsoft Word is divided into 

multiple sections with the name Clipboard, Font, Paragraph, Styles & Editing. 

The detailed explanation about Home Tab in Microsoft Word is given below. 

 Clipboard 

 Font 

 Paragraph 

 Styles 

 Editing 
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2.INSERT TAB  

Insert Tab in Microsoft Word is use for inserting the objects in the documents, 

such as – pages, charts, pictures, symbols, tables, shapes hyperlinks etc. The 

ribbon of Insert Tab in Microsoft Word is divided into multiple sections with the 

name Pages, Tables, Illustrations, Links, Header & Footer, Text and Symbols. The 

detailed explanation about Insert Tab in Microsoft Word is given below. Insert Tab 

in Microsoft Word is use for inserting the objects in the documents, such as – 

pages, charts, pictures, symbols, tables, shapes hyperlinks etc. The ribbon of 

Insert Tab in Microsoft Word is divided into multiple sections with the name 

Pages, Tables, Illustrations, Links, Header & Footer, Text and Symbols. The 

detailed explanation about Insert Tab in Microsoft Word is given below. 

 

 Pages 

 Table 

 Illustrations 

 Links 

 Header & Footer 

 Text 

 Symbols 

 

3.DESIGN 

The template or the design in which you want your document to be created can 

be selected under the Design tab. choosing an appropriate tab will enhance the 

appearance of your document 

 Themes 

 Page Background 
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4.PAGE LAYOUT 

Page Layout Tab in Microsoft Word is use for document page settings like 

appearance of page, page orientation, page size, page margins, page effect, border 

etc. The ribbon of Page Layout Tab in Microsoft Word is divided into multiple 

sections with the name Themes, Page Setup, Page Background, Paragraph and 

Arrange. The detailed explanation about Page Layout Tab in Microsoft Word is 

given below. 

 Page Setup 

 Paragraph 

 Arrange 

 

5.REFERENCES 

Reference Tab in Microsoft Word is use to create the table of contents, images 

caption, cross –references, footnotes, citation & bibliography etc. The ribbon of 

Reference Tab in Microsoft Word is divided into multiple sections with the name 

Table of Contents, Footnotes, Citations & Bibliography, Captions, Index and Table 

of Authorities. The detailed explanation about Reference Tab in Microsoft Word is 

given below. 

 Table of Contents 

 Footnotes 

 Citation & Bibliography 

 Captions 

 Index 

 Table of Authorities 
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6.MAILING TAB 

Mailing Tab in Microsoft Word is use for creating envelopes, labels and Mail 

Merge. Mail Merge is a feature for sending a letter to the multiple recipient at a 

time with separate details like address and greetings lines. It is a most useful 

feature in offices or companies for sending any information to multiple employees 

at a time. Alternatively we can use this feature to create multiple payslips or id 

cards at a time with separate details. 

 Create 

 Start Mail Merge 

 Write & Insert Fields 

 Preview Result 

 Finish & Merge 

 

7.REVIEW TAB 

Review Tab in Microsoft Word is use for checking spelling & grammatical 

mistakes in the document, write comments, track changes if the document 

modified, comparing document with another and document protection etc. The 

ribbon of Review Tab in Microsoft Word is divided into multiple sections with the 

name Proofing, Comment, Tracking, Changes, Compare and Protect. The detailed 

explanation about Review Tab in Microsoft Word is given below. 

 Proofing 

 Comments 

 Tracking 

 Changes 

 Compare 

 Protect 
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8.VIEW TAB 

View Tab in Microsoft Word is use for changing the layouts of the pages, 

show/hide elements such as – ruler or grid-lines, adjusting pages with zoom 

option, working with multiple windows and recording a macro etc. The ribbon of 

View Tab in Microsoft Word is divided into multiple sections with the name 

Document Views, Show/Hide, Zoom, Window and Macros. The detailed 

explanation about View Tab in Microsoft Word is given below. 

 Document Views 

 Zoom 

 Window 

 Macros 

 

MS EXCEL 

Introduction to Microsoft Excel: 

Microsoft Excel is an electronic spreadsheet. You can use it to organize your data 

into rows and columns. You can also use it to perform mathematical calculations 

quickly. Excel is a spreadsheet program that allows you to store, organize, and 

analyze information. 

1) Calculation: 

In Excel, a formula is an expression that operates on values in a range of cells 

or a cell. For example, =A1+A2+A3, which finds the sum of the range of values 

from cell A1 to cell A3. 

2) Mathematical Function: 

 SUM: It returns the sum of numeric values in a cell. You can refer to the 

cells where you have values or simply insert the values into the function. 
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 MAX & MIN: The MAX and MIN functions help in finding the maximum 

number and the minimum number in a range of values. 

 AVERAGE: It returns the average of numeric values in a cell. You can refer 

to the cells where you have values or simply insert the values into the 

function. 

 COUNT: It returns the count of numeric values in a cell. You can refer to the 

cells where you have values or simply insert the values into the function 

 COUNTA: It is Like the COUNT function, COUNTA counts all cells in a given 

rage. However, it counts all cells regardless of type. That is, unlike COUNT 

that only counts numeric, it also counts dates, times, strings, logical values, 

errors, empty string, or text. 

 COUNTBLANK: This function is a premade function in Excel, which counts 

blank cells in a range. 

 

3) Logical Function: 

 IF: This function returns a value when the specific condition is TRUE and 

returns another value it condition is FALSE. The IF function is often used 

when you want to sort your data according to a given logic. The best part of 

the IF formula is that you can embed formulas and function in it. 

 SUMIF: You use the SUMIF function to sum the values in a range that meet 

criteria that you specify. The SUMIF function syntax has the following 

arguments: 

 COUNTIF: This function is used for counting cells within a specified range 

that meet a certain criterion, or condition. there are only 2 arguments, both 

of which are required: 

 

4) Charts : 

Charts are visual representations of data used to make it more understandable. 

Commonly used charts are: 

5) Sparkline: 

Sparklines are tiny charts that reside in a cell in Excel. These charts are used to 

show a trend over time or the variation in the dataset. You can use these 
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sparklines to make your bland data look better by adding this layer of visual 

analysis. In Excel, there are three types of sparklines: 

 

6) Sort: 

The Excel SORT function sorts the contents of a range or array in ascending or 

descending order. Values can be sorted by one or more columns. SORT returns a 

dynamic array of results. 

7) Sub-Total: 

Use Excel's built-in Subtotal feature to automatically add subtotals and grand 

totals to a worksheet list of data, show and hide details. Subtotal pros and cons. 

Fix problem of duplicate grand totals. 

8) Freezing: 

When working with large datasets in Excel, you may often want to lock certain 

rows or columns so that you can view their contents while scrolling to another 

area of the worksheet. This can be easily done by using the Freeze 

Panes command and a few other features of Excel. 

9) Auto Filter: 

Excel AutoFilter is an easy way to turn the values in Excel columns into specific 

filters based on the cell content. Excel AutoFilter allows us to slice and dice our 

data per our requirements. We can filter based on our choices from a list or 

search for the specific data we want to find. The rows which do not meet the 

criteria of the filters will be hidden. In simple words, AutoFilter in Excel allows us 

to view specific rows in Excel while hiding the other rows. When Excel AutoFilter 

is added to the row’s header, it gives us a drop-down menu in the header row.  

10) Advance Filter: 

Excel's Advanced Filter is really helpful when it comes to finding data that meets 

two or more complex criteria such as extracting matches and differences between 
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two columns, filtering rows that match items in another list, finding exact 

matches including uppercase and lowercase characters, and more.    

11) Conditional Formatting 

As the name suggests, conditional formatting is a type of formatting that is 

applied to cells or ranges when certain conditions are met. These conditions are 

set, but can quite often be customised and edited, in rules that have been 

programmed into Excel. 

 

MS POWERPOINT 

Introduction to PowerPoint: 

Microsoft PowerPoint is a professional presentation program that allows the user 

to create "presentation slides" that can be displayed on the computer screen or 

through a projector that is plugged into the computer.  

1) Home Tab 

The Home Tab in Microsoft PowerPoint contains all the necessary commands 

for inserting and editing slides in a presentation. It usually contains shortcuts 

to some of the most commonly used features that are available in other tabs in 

PowerPoint. 

 

 Clipboard: 

The Clipboard group is the first group in the PowerPoint Home tab. It contains 

the cut and the paste functions: 

 Slides: 

Slides in PowerPoint are crucial to making any presentation. Thus, 

the Slides group in the Home menu includes five commands which are all 

dedicated to adding slides, removing slides, and changing the layout of the slides. 

https://artofpresentations.com/slides-in-powerpoint/
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 Font: 

This group contains all the functions related to the fonts in PowerPoint. The 

commands in the Fonts group are primarily used for editing the text in a text 

box of a slide. 

 Paragraph: 

The Paragraph group in the Home tab contains functions to edit paragraphs or 

text within a text box. 

 Drawing Group:  

 Editing Group 

 

2) Insert Tab  

 Tables: 

 Illustrations: 

 Text: 

 

3) Design Tab: 

 Page Setup: 

 Themes: 

 Background: 

4) Transition Tab: 

Transitions are animations that you can use when advancing from one slide to 

the next during a presentation. They can be fun, but be careful not to overdo it 

with complicated transitions because they can become distracting. 

  Effect Options:  

 Timing: 
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5) Animation Tab 

In PowerPoint, you can animate text and objects such as clip art, shapes, and 

pictures. Animation or movement on the slide can be used to draw the audience's 

attention to specific content or to make the slide easier to read. 

 The four types of animations: 

 Effect options 

 Timing  

6) Slide Show Tab: 

 Start Slide Show 

 Set Up 

 Monitors 

 

7)  Review Tab 

 Proofing 

 Comments 

8) View Tab 

 Presentation Views 

 Show/Hide 

 Zoom 

 Color/Gray scale 

 Window 

 Macros 
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MS ACCESS 
Microsoft Access is a Database Management System offered by Microsoft. It uses 

the Microsoft Jet Database Engine and comes as a part of the Microsoft Office 

suite of application. 

Elements of database  

1) Tables: 

2) Relationships 

 One-to-One: A single instance of an entity is associated with a single 

instance of another entity. This type of relationship is relatively uncommon; 

it is typically used when an entity can be classified into several sub-types. 

An example where a one-to-one relationship might be used is one teacher 

teaching only one course. 

 

 One-to-Many: An instance of an entity (called the parent) is associated with 

zero or several instances of another entity (called the child). An example of 

this type can be found by examining the teacher and class entities. A 

teacher may instruct zero or more classes during the course of a semester. 

 

 Many-to-Many: Many instances of an entity are associated with many 

instances of another entity. Consider the enrollment relation between a 

student and a class. A single student may be enrolled in many classes, and 

a single class may enroll many students 

 

3) Querries: 

Queries are used to view, change, and analyze the data in different ways. Queries 

can be used as the source of records for forms and reports. You can formulate 

simple queries that look for records. A query displays a subset of all or specific 

fields and records in a table. 

 Simple query 

In simple query you can select different fields from different tables and find 

a particular data. here the condition specified for the query is constant. 
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 Query Parameter:  

In query parameter you can enter the condition at runtime, i.e. during the 

execution of the query, and then query parameter must be specified. If a 

query parameter is entered, then while executing a query, it will ask the 

user to enter a value based on which the result will be displayed. 

 

 Calculated Query: 

A query can display the content of fields or the result of calculation specified 

using the fields in the tables. The table contains the field deposit. Using this, 

the discount can be calculated as 25% of deposits and displayed. 

 

 Make Table Query:  

When you run a select query MS-Access shows a Datasheet View that draws 

its data from the tables included in the query. If you edit the datasheet view, 

you end up changing the data in the underlying tables. At such times you 

can save the data in new tables so that you do not alter the original tables. 

Basically you can add fields from different tables and make a new table. 

 

 Update Query: 

Update query can be used to make global changes to a table instead of using 

edit replace to change one record at time. 

 

 

4) Form  

 You can use the form tool to create a form with a single mouse-click. When you 

use this tool, all the fields from the underlying data source are placed on the 

form. You can start using form immediately, or you modify it in Layout view or 

Design view to better suit your needs. These are direct forms: 

 Form Design: 

In form design you can select different fields from different tables on a blank 

form by using add existing fields feature. 

 

 Command Buttons: 

Command Buttons are like the OK or CANCEL buttons that you see in most 
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of the window-based applications. When you click on a command button, 

MS-Access automatically performs a predetermined function. You can 

associate one or more functions with command buttons. 

 

 List Box & Combo Box: 

using list control you can add different fields from the tables and make a 

List Box or a Combo Box. A list box and a combo Box can be used to locate 

a particular record instead of for 

 

5) Reports  

Report is a component of the database, which is used to organize and present the 

data in the tables in an understandable form. MS-Access allows us to base a 

report on a query as well as on a table. 

 

INTERNET 
The Internet is a global network of billions of computers and other electronic 

devices. With the Internet, it's possible to access almost any information, 

communicate with anyone else in the world, and do much more. 

One of the best features of the Internet is the ability to communicate almost 

instantly with anyone in the world. Email is one of the oldest and most universal 

ways to communicate and share information on the Internet, and billions of 

people use it. Social media allows people to connect in a variety of ways and build 

communities online 

 

 

 

https://edu.gcfglobal.org/en/email101
https://edu.gcfglobal.org/en/topics/socialmedia
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SOFT TOUCH TYPING 
Soft Touch Typing is the ability to type using all your fingers, without looking at 
the keyboard. This is a valuable skill for employers because it enables employees 
to produce and edit text at a much faster speed than usual, helps us to finished 
work at greater level of accuracy, provides better work experience and more time 
available for other tasks. 

TALLY PRIME & GST 

 Accounting Fundamental 

 Accounting is consolidating the financial transactions of a company 

using a systematic approach. It involves recording, analysing, 

reporting, and retrieving financial transactions when required. It 

follows a systematic process right from recording a transaction in 

books to generating reports. 

 

 Maintaining Accounts 

 You can record transactions necessary for your business by creating 

and maintaining masters, vouchers, and generating reports. 

 

 Accounts using Inventory 

 Inventory means stock; the trader's sells are called goods. Inventories 

include the purchases, sales of stock or stock movements. The closing 

stock of a particular year becomes the opening stock of the next year. 

 

 Accounts in Voucher 

 A voucher is a document that contains details of a financial 

transaction and is required for recording the same into the books of 

accounts. For every transaction, you can use the appropriate Tally 

voucher to enter the details into the ledgers and update the financial 

position of the company. 
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 Bill of Material 

 A Bill of Materials is a list of constituent items along with quantity 

details that can be allotted for the manufacture of a certain product, 

by-product or likewise. This facilitates immediate reduction in stock of 

the item automatically. 

 

 Zero Value Entries 

 Zero-valued entries are those entries where a voucher entry is made 

without any values, that is, one of the parameters (Qty or Rate) may 

not have a value but needs to updated in the records. 

 

 Budget 

 A budget is a plan prepared for the flow of funds in an organisation. It 

contains financial guidelines for the future plan of action for a selected 

period of time. A budget helps to refine goals and use funds efficiently. 

 

 Security Control 

 By default, there are two types of security levels. One is the Owner and 

the other is Data Entry . Owner - The owner has full access rights 

which will enable him to work with all the features except for Tally 

Audit and Company Alteration which are reserved for the 

Administrator. 

 

 Tally Audit 

 Tally has an inbuilt feature- Tally Audit which enables the auditor to 

perform an audit or track changes that affect the integrity of a 

transaction, such as changes made to Date, Ledger Masters and 

Amounts in the Voucher are reflected in the Tally Audit Listings. 

 

 Backup & Restore 

 You can restore the data of companies for which you have taken a 

backup. When your current company data is lost or corrupted, you can 
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restore your last backed up data using the Restore option in Tally. 

 

 Interest Calculation 

 Interest is a legitimate return on money invested and chargeable in the 

business world on loans and also on delayed payments. Interest can be 

calculated on the basis of Simple or Compound Interest. With Tally you 

can obtain reports on interest calculated based on the configurations 

made. 

 

 

 Actual & Billed Qty 

 In some trade, the quantity delivered and quantity billed may be 

different. Recording of Actual Quanties and the Billed Quanties are 

essential to get the accurate stock values and sale/purchase value 

 

 Inter- State Transaction 

 When the supply of goods or services happens within a state, also 

called intra-state transactions, then both the CGST and SGST will be 

collected. Whereas, if the supply of goods or services happens between 

the states, also called inter-state transactions, then only IGST will be 

collected. 

 

 Tally to Excel Export 

 You can export masters and transactions created in a company, in 

different formats. You can also choose the type of masters and 

transactions to export. Masters and transactions exported in XML 

format can be imported into Tally Prime using the Import feature.  

 

 Cheque Printing 

 The Cheque Printing option in the Banking menu enables you to print 

the pending, already printed or the required cheques continuously 

from a single screen. You can also update the cheque details and have 

track of cheques to be printed, of a selected or all banks. 
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 Printing Formats 

 Printing invoices and reports for different business needs is quite 

common. Tally Prime supports different print requirements, such as 

printing multiple invoice copies, printing on a specific paper type, or 

using a specific print format 

 

 Multiple Address 

 The Multi Address feature in Tally allows you to maintain multiple 

mailing details for your company and ledgers. Create multiple 

addresses for your company and use them in invoices and reports. 

 

 Bill Settlement 

  Managing the outstanding receivables can be critical to your business 

because it not only helps to understand how much your parties owe 

you, but also helps you to recover the dues on time and use it for your 

business, as needed. You can manage outstanding receivables in Tally 

Prime and keep record of all the dues 

 

 Email in Tally 

 You can e-mail the reports daily to a pre-defined audience, who might 

be stakeholders inside or outside your company. 

 

 TDS 

 Tax Deducted at Source (TDS) is an indirect tax and a means to collect 

tax at prescribed rates from the source of income. TDS in Tally 

provides an easy-to-use and flexible interface. It helps you to handle 

intricate cases and calculate the tax payable to the Income Tax 

Department. 

 

 GST Services  

 In simple words, Goods and Service Tax (GST) is an indirect tax levied 

on the supply of goods and services. 

 

-X- 


